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Introduction 

DentalEye handles and manages images in the modern dental practice. 
It integrates with all digital sources, offers advanced image 
manipulation and optimisation, as well as simple and efficient image 
management. These pages are designed to help you understand the 
program, its many functions and how to use them.  

 

General Information  

DentalEye is an open architecture 32-bit, Windows based system 
providing compatibility with main brand digital sensors and intraoral 
cameras. The software allows integration with existing systems and can 
be connected to almost any database and database engine. DentalEye 

comes with a set of ready-made templates but the user can also make 
custom templates to suit individual requirements. The software offers a 
comprehensive range of tools for image manipulation, cosmetic imaging 
as well as advanced optimizing features such as compensation for 
exponential X-ray attenuation and a colour scale specially developed for 
use in dental radiology.  
 
The software allows integration with existing systems and can be 
connected to almost any database and database engine. DentalEye 
comes with a set of ready-made templates but the user can also make 
custom templates to suit individual requirements. The software offers a 
comprehensive range of tools for image manipulation, cosmetic imaging 
as well as advanced optimizing features such as compensation for 
exponential X-ray attenuation and a colour scale specially developed for 
use in dental radiology.  

    
   Database handling  
 
Create new database  

Selecting System | Create new database will take you to a dialogue for 
this purpose.   
The dialogue has the following options:  

- Select Microsoft SQL-server if you have 
either Microsoft SQL server 7, Server 2000, Server 2003 or MSDE 
(Desktop edition) installed in your system and intend to use it for 
your Dentaleye database. Select Microsoft Access if you want to 
use this type of file based database. Access is suitable for 
networks up to about 5 concurrent users while SQL is 
recommended for use in larger networks. It is possible to convert 
an Access format database to a SQL database later if needed. As 
the SQL database is more complicated to install we recommend 
that it is only installed by experienced staff.   

options for this type: For SQL you must provide a Server name 
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(the name of the computer where SQL is installed) and a 

Database name of your choice. For Access you must provide Path 
and file name for your database file.  

- this is the folder where your images will be 
stored. It does not need to be the same as where your database 
resides.  

database from CD - if you check this option some 
patients, templates, images and anatomic descriptions will be 
added to your new database.  

- if you check this option some basic 
templates and anatomic descriptions will be added to your new 
database.  

When clicking OK the database will be created and selected as your 
default choice. If you intend to use this database from all workstations in 
your network you must select the database on each one of them. Make 
sure that you have a backup system covering the folders that you 
selected before you start using the system. If you run SQL you must 
make sure that the database files are backed up properly. Consult your 
network supplier if you're not sure how to do this.  
 
Local database info  
Selecting System | Local database | Local database info; will open a 
window with information about the currently selected database.  
You will see where the database is located and what version it is.  
You can also see how much free space you have in your Image 
stores. Some statistics from the database is also presented including 
number of patient, images and templates.  
 
Setting database  
Selecting System | Setting database will open a dialogue where you 
choose your active database and edit the image store settings.   
Most likely you will only use this function when installing the system. 
When creating your database on one workstation you will have to use 
Setting database to select the newly created database on the other 
workstations.  
The dialogue has the following options:  

- Here you have to choose the same type of 
database used when creating it.  

- Here you provide the login information for 
your SQL server. For Access databases this is currently not 
relevant.  

ur database type choice you will be presented 
options for this type: For SQL you must provide a Server name 
(the name of the computer where SQL is installed) and then 
choose Database name from the list. For Access you must provide 
the Path and file name of your database file.  

- This is where you can administrate 
your image stores. An image store is a folder where images are 
stored. You can have more than one image store but only one 
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selected as active. The active image store is where new images 

will be saved. The others are only used for retrieving old images. 
Please note: Currently you need read and write permissions both 
in the active and the non active image stores. It is possible to Add 
new image stores, Delete image stores with no images in them 
and Change path (...) to an image store.  

 
The database selection is saved as default for the currently logged in 
user only. If you log in with a different username you will have to use 
Setting database for that user too. This is useful in the case where 2 
users wanting different databases but work on the same PC. 

 

Patient Handling  

Register a new patient in DentalEye  

When DentalEye is used independently of the PM system, DentalEye will use its 
own internal patient management system to register and edit patients.  
In order to add a new patient to the database click the new patient icon  or 
choose Patient >New Patient from the menu. 
Fill out the form. Use TAB or left-click to move to the next field. NI or Social 
Security numbers are required in order for patient to be registered.  
 

Integration with Practice Management systems 

DentalEye can bridge to or integrate with any Practice Management system. This 
is normally done with a link which the manufacturer of the PM system connects 
to. Select a patient in the PM system, then click the icon (normally) which opens  
DentalEye and brings up the patient. If the patient is new it will be added 
automatically. If there are any changes on the patient it will be updated.  

Find patient 

Open the Find patient window by clicking the find patient icon   or choose 

from the menu Patient >Find patient 
In Search for, the last setting used is preselected. To select other alternatives, 
left-click on the drop down list.  
In Beginning with/Containing, write what you are looking for. DentallEye has 
two different search criteria: 

 A continuous string anywhere in the field. This is used in First name, 

Address and Comments. For example, when searching by address you could 
write the place name. 

 From the beginning of the field. Used in all other fields. 

 With wildcard % or * in the beginning followed by a part of the number or 
name. 
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 Free text search finds a the string wherever it is in the patient-file. E.g. 
the street-name or a part of the name or a part of the first name.  

The search result can be sorted by any of the columns by clicking the title above 
the column. 
 

 
 
The most common way to search is: 
Last name or number. You begin by writing the last name and the results will 
appear similar to a phone book. When you see the right name in the list select it 
by using left-click or double-click, or use the arrow keys and press <Enter>. 
 When you only remember a part of the patients name use the wildcard and type 
the string you remember e.g. *von. 

Edit patient information 

All but the NI or Social Security number can be changed. 
Open the Edit patient info from the menu Patient >Edit patient info 
Use TAB or left-click to move to the next field.  
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About the General Toolbar buttons  

 

To activate a command click it’s toolbar button or press function keys, or 
combination keys. The menu toolbar buttons are enabled or displayed 
corresponding to where you are in DentalEye. For example with no patient 
selected there are only three buttons enabled, namely New Patient, Find 
Patient and Work with Templates. As soon as a patient is selected all the 
other buttons are enabled, except for Work with templates and Add image 
frames to templates.  

The menu Bar contains the following buttons:  

 Find Patient (<F4>)  

 Search for Patients in MedicalEye 

  New Patient (<F2>)  

 Register New Patients in Medical Eye  

  Edit Patient (<Ctrl>+E>)  

 Change and edit patient info such as name address etc.  

Print (<Ctrl>+P>)  

 Printing Images and Image Cards  

 Save (<Ctrl>+<S>)  

 Save new template/image card or updated information  

 Save As  

 Save as is used when you want to save your template or  image card 
 as a copy preserving the original. Save is  automatically redirected to 
 Save As with newly created unsaved image cards and templates.  

 Undo  

 Undo is used to retract your last action 
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 Redo  

 Redo makes the last Undo action undone.  

 New  (<Ctrl>+<N>) 

 The New Button is used to clear the work area i.e. when creating a 
 new template or a new image card.  

 Show/Edit image info (<Ctrl>+<I>) 

 For every image there is a collection of data and image information  

 Find Images (<F3>)  

 Searching for a patient’s images.  

Delete (<Del>) 

 Delete images, image cards and templates. Requires permission  

 Presentation Overview  

 Show images from clipboard in a presentation view.  

Show/Hide List  

 An On/Off button to show the image card without the image list  

Show/Hide Grid 

 An On/Off Button to show the grid on the image card  

Show Template  

The selected template is displayed on the image card 
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About the Image Toolbar  

The tools are activated one at a time by a mouse click and will affect the 
selected image on the image card. Alterations to the image will transfer 
between the two image card views, but will not appear in the image card list, 
as this can only contain original images. Altered images are saved on the 
image card and the originals remain in the image list. You can toggle between 
viewing and hiding the toolbar by left clicking on the Image toolbar button, 
or right clicking on the bar and choosing the toolbar from the menu, or 
choosing Customise.  

 

The Image toolbar contains the following tool buttons.  

 

 Reset 

Resets the pointer to the normal state where you can move and resize images 
on the imagecard. Deactivates other selected tools. 

 

 Revert to rotated/mirrored original 

The image is reverted back to its original except for rotation and mirroring. 
 
 

 Mirror 

 
 Flips the image to a mirror image of the Image. Mirror is also available as an 
auto filter in System - Preferences - Capture.  

 Show/Hide Brightness/contrast tool 

 
A clickable on/off combination tool in the shape of a moveable red spot. The 
spot is moved by drag and drop, controlling contrast vertically and brightness 
horizontally. Right-clicking in the frame gives you the numerical values. The red 
spot is also controlled by Ctrl + arrow keys. 
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Another way to change the brightness and contrast on an image is to hold down 
the Ctrl-key on the keyboard, press down the left mouse key and move the 
mouse in the same way as on the tool.  
Note: if this tool does not work you probably forgot to turn off the annotation 
 

Soften/sharpen filter  

The tool Soften/Sharpen is used to either soften or sharpen edges in the image. 
When clicking the tool button a slide-bar appears. Drag the slider and the image 
and the image is changed correspondingly. If you want to remove noise use the 
Noise reduction tool instead. 

 Histogram, show/hide 

Is an on/off button for the histogram showing the amount of different grey 
shades in the image. For example, with the histogram you can tell if an image is 
under- or overexposed. The image below shows that the greyscale is well spread 
over the 0-255 range and that the X-ray seems to be well inside the borders and 
not wrongly exposed.  
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Stretch histogram 

 This is a tool to enhance certain greyscale levels in the image. It is 

important to know that the area outside of the enhanced area will be neglected.  

 

Invert 

 Replaces black with white and vice versa, producing a negative of the 

image. Makes it easier to spot changes in the bone-area. 
 

Equalization 

 Opens a magnifying glass in the image which enhances the area viewed, 

roll the mouse wheel to enlarge the magnifying  
 
 

 Edge enhance 

Increases contrast to make the edges in the image clearer.  
 

 Optimize brightness and compensate for X-ray attenuation  

 This tool does two things to enhance the whole image based on the values 
in an area of interest. 

 

 Magnifier 

This tool is a magnifying glass. Left-click on the tool button and the mouse 
pointer changes.  
 

Colorize 

 Turns the grey scale into a colour scale that is scientifically proven to 

enhance the ability to determine between different shades of grey. This tool lets 
you benefit from the fact that it is easier for the eye to distinguish colour 
changes than greyness changes.  
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Customize the toolbars 

All functions are available as icons, but not displayed with the default 
settings. In order to customize the toolbars do as follows: 
1 Right click in the grey area besides the icons. 
2 Choose customize from the menu 
3 Choose the Tools tab. 
4 In order to add an icon/button to the toolbars press the left mouse 
button and drag it to the desired position drop the icon by releasing the 
mouse button. 
To remove a button from the toolbar act as above but drag it from the 
toolbar and drop it inside the customize window. 

 

Image acquisition 

When a hardware device and it's plug-in is installed, a continuous group of tools 
will be added to the toolbar. A new menu item will also be added to the Tools 
menu.  DentalEye allows you to work with images, image cards, series and 
templates. It is important that you understand the difference between these and 
how DentalEye is set up to work.  

The group  belongs to an X-ray sensor.  

 

A click on activates the  Plug-in 

 

A click on  deactivates the Plug-in 
 

A click on  shows the Plug-in settings.  

When using DentalEye with hardware plug-ins it is necessary to firstly open 

the correct patient and then activate the hardware through the icon on the top 
right hand side of the toolbar that corresponds with the desired device, active 
by clicking upon this icon, the icon should the change from red to green and 
you are ready to start saving images. Before randomly saving images it is 
however necessary to chose how you would like to save these images. This is 
explained in the next couple of pages.  
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Too capture a bite-wing series 

The sensor is probably auto activated and the red/green dot on the sensor 

plugin is green.  If not activate the sensor with the 

Activate button . 

Check that the right template is selected, the default is the last used template. 

 
(Rem: in System - Preferences - Capture you may assign a standard template 
to an image device.) 
1. Position the sensor for the first X-ray, go out and trigger. 
2. Check the image with a quick glance at the computer screen. 
3. Reposition the sensor, go out and trigger, repeat until the series is ready. 
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Anatomic descriptions 

DentalEye works with an index of anatomic descriptions, which every 
clinic can organize, reflecting their own procedures and requirements. 
The idea behind this feature is to make it easy to define a particular area 
on your images. DentalEye uses the anatomic descriptions when a 
template is used while capturing images. The anatomic descriptions will 
be assigned to the image automatically. Thus making the anatomic 
descriptions searchable e.g. search for all BW molar right from the last 3 
years. Furthermore since the teeth in an anatomic description are 
assigned to the image, a particular tooth can be searched for 
independently of the type of anatomic description it belongs to. E.g. 
search for all canine upper left from the last 3 years. 
To start with, DentalEye provides you with a set of anatomic 
descriptions, including specific teeth, which are used by many dentists.  
Go to the menu bar and choose Tools > Show/Edit anatomic 
descriptions. 
 

 
 

 To create a new anatomic description, press the New button. 

The text NEWAD (new anatomic description) is shown at the 
bottom of the list and in the Name field. 

 Enter the name of the new anatomic description and indicate the 
teeth concerned by clicking them on the tooth chart. The teeth 
will be marked blue and will be included in the anatomic 
description. You can choose between adult and milk-teeth by 
clicking the radio buttons. 

 To remove an anatomic description, you select it in the list with 
a mouse click, then press the Delete button. If an anatomic 
description has been used for an image or a template frame that 
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is stored in the database, you cannot remove that anatomic 
description. 

 To change the contents for an anatomic description, you select it 
in the list with a mouse click. Then edit the contents on the 
tooth chart. 

 In the Comments box, you can write information concerning 
the selected anatomic description. The comment will only be 
visible in Show/edit anatomic description.  For instance, you 
might want to enter the date a new anatomic description was 
introduced into the system. 

 For convenience, arrange an order that will be easy for you to 
follow. You can change the order by selecting an anatomic 
description, then pressing the big arrow buttons below the list 
box, to move the anatomic description up or down, one step at a 
time. It is advisable to keep an anatomic description without any 
teeth at the top of the list. This one will be used as default and 
is needed for images that do not correspond to any anatomic 
description. Obsolete groups should be placed at the bottom of 
the list. 

 
The list of anatomic descriptions will appear at certain points e.g. in the 
Template manager
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Create and edit templates 

A template is created by the arrangement of one, or several image 
frames, on an image card. Check teeth contents for the tooth groups 
that are to be included in the template. If they do not suit your needs go 
to Show/Edit anatomic description and make necessary changes. 
(If you have special settings for this particular template, you can reset 
the tooth group list, once the template is ready. This will not affect the 
newly created template.) 

Create new templates  

1 Open the Template manager window with a click on the Templates 
tab. 
 

 
 
An empty work space named New Template is opened as default. If you 
prefer to use an existing template to create a new template click on the 
template in the Taskpane, in order to keep the used original template 

click on the Save as icon  and give the the template a new name. 
2 Add frames 
In the Tools menu Add image frame to template or use <Ctrl>+<M> 
for the number of frames needed in the template. The frames will appear 
on top of each other at the top left corner. 
 

 
 
3 Once the series of frames is completed, place the frames (drag and 

drop) in the way you want the resulting image card to look. Size can be 
adjusted one frame at a time, by dragging any corner. To display a grid 
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that will help to place frames evenly click on the grid icon   In many 

cases it is simpler to take the images in the size they come and place 
them in the desired arrangement against the upper left corner. Resizing 
can then be done collectively by moving the edges of the image card 
towards the frames. 
4 Now change the properties to your needs, mark the frame you are to 
change. 
 

 
 
Sequence number X tells DentalEye that the X:d captured image shall be 
placed in this frame and get the properties for this frame.  
Frame number is just DentalEye:s way to number this frame. 
Proportions designates the relation between widht and height for the 

image. An image that is displayed in landscape (horizontal) mode 
normally has 0,7 as the proportion. 
Rotation - Set the Rotation for correct presentation of the images on 
the screen. If you are unsure of the required rotation, leave the field as 
is and perform a test run as described under the topic Test run. Intraoral 
sensor images are normally displayed right (rotation 0°) when the cord is 
aiming down. 
Anatomic description - chose the right anatomic description from the list 
made up in Show/edit anatomic description. 

5 Save the new template by clicking the icon Save as  or if the 

template already has a name Save  . 
The window Save template appears suggesting a name for the 
template. Choose an instructive name containing relevant information, 

i.e. ”BW 4 horizontal” (Bitewing series of 4 images using a sensor 
horizontally.) The template list is updated with the new template. 
Edit templates 
1 Select by clicking on a template in the Template list  
2 To add a new frame, click the Add image frame to template button 
or <Ctrl>+<M>.  
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3 To make changes within a frame, click the frame and make desired 

changes 
4 Click the Save or the Save as button (Look at step 5 above).



DENTALEYE Users Guide 

 Page -  19 

Delete frames/template 

Template frames as well as the self-made templates can be deleted, 

 there are some templates marked that cannot be deleted. 

Delete frames 

1 Select the frame to be deleted by clicking it. 

2 Click the Delete button  (or<Del>) 

3 A dialogue box appears asking 'Are you sure?' 
4 Click Yes and the frame disappears. 

Delete Templates  

1 Select the template in the template list by clicking it. 

2 Click the Delete button  (or<Del>) 
3 Click Yes in the dialogue box and the frames as well as the template 
name disappears instantly 

Work with templates 

The template is a flexible tool and can be used for several purposes. It is 
therefore important to understand the different functions. You enter the 
Template manager at the very right of the lowest icon-bar. 
 

 
 
A template consists of frames arranged on an image card. Each frame 
contains five properties with guiding functions for the image that will 
end up in the frame. The frame properties will be used to add properties 
to a captured image and based on the image properties the image will be 
positioned, sized, rotated and assigned the right Anatomic description. 
There are some default Templates that you may not delete but they may 
be hidden by clicking on Hidden in the properties list and select Yes.   
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File menu 

 

 

 

Save (<Ctrl>+<S>) 

Save a new template/image card or any updated information. Saves the 
information in the current name.  
 

Save as 

Save as is used when you want to save your template or image card as a 
copy preserving the original. Save is automatically redirected to Save As 
with newly created unsaved image cards and templates. Tip: in order to be 
able to edit an image card, bring up the original series (which cannot be 
changed) and save as a new name. The newly created image card is now 
open for new images and can be edited. 
 

 Save and approve 

Saves and approves the image. Rem: approve is used if personel without 
right to approve images are capturing images and needs to save in the 
database for later approval by qualified personel. The save function can be 
set up to approve when save if this is not needed. 

 Import from text file 

Internal import is used when another DentalEye user has exported a text 
file with patient and image information. The file can either have been 
sent as an e-mail or on a disc. DentalEye gives a default name to the 
files, DEExport.txt and DE1.cmp, DE2.cmp... (.cmp is the image file 
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format that DentalEye uses). If you have received an e-mail with 

multiple files, it is not necessary to know which of them that belongs to 
the text file. The images may be previewed as in the external import 
case, but for the import as such the procedure is different. The choice of 
patient has no bearing. 
Go to the menu bar and choose File | Import from text file 
Browse for the received file (DEExport.txt).  

 Click the Open button. A window will display the content of the 
package. 

 Click the OK button in the window. 

The import is now completed and includes patient and image information 
as well as the images. The images are now stored in your database in 
the same condition as your own images. 

 Close 

Closes current patient. 

 Print (<Ctrl>+<P>) 

Brings up the Print window were you select what and how to print. Images 
and image cards can be selected and arranged for printing in different 
ways. Go to the menu bar and choose File | Print, or click on the tool 

bar  , or <Ctrl>+<P> 

A Print window appears containing following items:  

 Select the printer of your choice from the printer list. 

 Click on Print Setup to go to printer settings. 

 Under Source you find a number of ways to select images and 
image cards. The check boxes are open according to your 
selection in the image list or on the image card. To select more 

than one image from the taskpane hold down the ctrl button and 
click on the second image and so on. To select a number of 
images at once click the one placed highest and hold down the 
shift key while clicking on the one at the bottom, all images 
between will be marked. 

Current series layout - Prints what you see on the active image 
care/series on the screen. 

 Under Options you find some options for the printout display. 

White background is there to save ink if you have a coloured 
background. 
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Print logo requires that a logo is selected, the selection is done 

with the button below. 
 

 
 
Individual images will be printed maximized one on each page. If you 
want more than one image on a page, create an image card with the 
layout of your choice and then select Current image card only in Source 
of the Print dialogue.  
When printing image cards the paper orientation will be selected 
automatically depending on the proportions of the image card. 
The printer and the paper usually limit the quality of the printouts. 
 

 Exit  

 
Exit DentalEye.
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Edit menu 

 

 

 Undo  

Undo is used to regret the last actions. You may step back and undo one 
action at the time. 

 Redo 

Redo makes the last Undo action undone. In case you undid to many 
actions it is possible to redo actions step by step. 

 Copy images to Clipboard 

The clipboard is a list containing copied images. The images can be copied 
from different patients and from the image list, Search results, Image 
cards and from the Clipart list. The clipboard content is preserved when 
moving to a different patient. The clipboard can contain a maximum of nine 
(9) images at the same time. 
Images can be copied from a patient's image list, Search result as well as 
from Image cards. It is also possible to copy images from the Clipart list. 
To copy images do one of following: 

 From the menu Edit | Copy 

 Right-click and select copy from the pop-up menu 

 Press <Ctrl>+<C> 

 

 Paste to Image card from Clipboard 

The clipboard images can be handled in the same way as images in 
general. However there is a special function for pasting images from the 
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Clipboard to the Image card. To paste images from the Clipboard to an 

image card do one of the following: 

 From the menu Edit | Paste the last image on the Clipboard is 
pasted 

 Press <Ctrl>+<V> also pastes the last image. 

 Mark all images on the clipboard (<Ctrl>+ left-click) and select 
Edit | Paste. 

 Clear clipboard 

To delete all images from the clipboard use the function Edit | 
Clear Clipboard. If you just want to remove a single image you 
can use the normal procedure: select the image and click 
Delete.How does Images, Image cards, Series and Templates 
work 

DentalEye allows you to work with images, image cards, series and 
templates. It is important that you understand the difference between 
these and how DentalEye is set up to work.  
To start with we will explain the different functions and the terminology 
and then some examples on how to setup DentalEye for different 
preferences. With version 3.1 the term Series has been added, a Series is 
an original imagecard that may not be altered. A Series will always be 
presented as it was when approved and saved meaning that the original 
will always be there if you need to get back to it. This new feature has 
been introduced to add even more security and quality assurance to 
DentalEye and it is also a requirement from the Dicom standard. A series is 
marked with a black ikon and an imagecard with a green icon in the 
imagecard list.  
Images are always stored in the patient file, the individual images on an 
image card are saved at the same instant as the image card is saved. By 
changing the view in the Task-pane to Images (down arrow beside the title 
in the Task-pane) all images stored on the patient file will be displayed.  



DENTALEYE Users Guide 

 Page -  25 

 
 

The Imagecard is the result when images has been exposed with a 
template.  An image card may also be built manually e.g. a case 
presentation that is built with an existing image card as a base and then 
added to with other images from the patient file. 

 
A Series is an original image card saved as exposed, such a series is 
always saved. A Series is marked with a black icon beside the name in the 
Task pane. As the Series is an original it is not open for editing. (The 
reason for this is the demands from the Dicom standard.) 
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Approved or non approved 
An approved Series cannot be altered or added to. However if needed the 
approval can be changed, provided that the userrights permits changing 
approval (System - Preferences - Security). The approval is changed by 
rightclicking on each image in a Series (or Imagecard) and choose "Change 
approval" from the menue. A Series will be opened for changes when all 
images in the Series are non approved. A non approved image has a red 
mark in the upper left corner as in the example below. 
 

 
 
Save automatically or manually 

A Series may be saved automatically as soon as it is captured or you may 
setup DentalEye to prompt you to save and have the opportunity to save 
with or without approval thus making the new Series to remain open for 
alterations and new images.  
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In order to eliminate the extra effort to have Series and Image cards mixed 
you may turn off the display of Series. Go to System - Preferences - 
General and mark "Hide approved original series in imagecard list". At the 
same instant as the Series is stored and hidden an exact copy is saved as 
an image card, which is fully open for manipulation and editing. However 
the original Series is always there if needed and can be displayed by 
unmarking the "Hide approved original series in imagecard list". 
 

 
 
Templates are used to make the images to fit in a layout and to assign 
preferences to images. Templates may be changed or added to suit your 

work flow, some Templates are installed with the software, but the idea is 
that every user shall be able to work exactly as preferred.  
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How to move images 

See a presentation on how to move images. 
If by accident images has been captured in the wrong patient-file, there is 
a way to copy the images to the right patient and then go back and delete 
them from the wrong patient. However since this is a very delicate 
operation we have choosen to make it a bit cumbersome and very 
restricted.  
Performing this operation copy and deleting images requires 
Delete-permission of the user. You might have to ask your 
Administrator to do the operation. 
Start in the patient-file where the images are. 
Change the taskpane view to show Images by clicking the down-arrow to 
the right of the taskpane title, select images from the menu.  
 

 
 
Select the images to copy. 
I you only need to copy one image click on it and the background becomes 
blue. 
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DentalEye supports the Microsoft standard of selecting more than one 

object. To select several images either click on the first and hold dom the 
ctrl-button and click the next, this way the 2-9 images may be selected. 
Or if the images are in squence click on the first and then go to the last 
hold down the Shift-key and click on the image, all images between should 
not be marked by showing a blue background. 
To copy right click on the marked area and choose Copy from the menu. 
 

 
 
Now the taskpane view should be changed to Clipboard, and on the 
Clipboard the copied images should be visible. 
REM: if you need to start over again the Clipboard must be cleared from 
old images, go to the Edit menu and select Clear Clipboard. The copied 
images will reside in the Clipboard as long as DentalEye is active. 
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Go to the patient the images belongs to. 

Bing up a new empty image card.  

Drag and drop the images from the Clipboard view in the taskpane onto 
the empty image card. Place and rotate the images in the image card. 
SAVE the image card under a name. 
 

 
 
Now the images are copied to the right patient, the final step is to go back 

to the wrong patient and delete the images. 
Go to the wrong patient. Change the task pane view to image cards. Mark 
the image card that contains the images that does not belong to this 
patient. Click on the Del-key on the keyboard. You will not see the change 
until you press F5 to update the patient or close the patient and go bac 

How to view images and image cards 

Some practical tips and tricks about how to view images and image 
cards in DentalEye.  



DENTALEYE Users Guide 

 Page -  31 

When a patient file is brought up the latest exposed image card is 

displayed as a default. The images are real images and may be diagnozed 
directly from the image card. (Most other systems only bring up thumbnails 
which are low res copies.) Use the Magnifying glass and move it from 
image to image on the image card. 
In order to see more double click on the first image on the image card to 
view it in single image view, use the TAB key on the keyboard to go to the 
next image directly, Shift-TAB brings you back to the previous image. 
Compare image cards in two different ways: 
1. Hold down the ctrl button and click on the image cards you want to bring 
up in the Taskpane view. (Rem. if the images becomes small when they 
are displayed together the background from old image cards is the 
problem. Go to the image card and drag the border of the background 
(defaul color is blue) to just cover the area with the images, save.) 
2. Use Find images, in the Find images window mark the Active box and 
select a template that fits the search e.g. Bitewing x 3. Click the Search 
button and all images that fits in to the selected Active template will be 
displayed in the template. The Bitewing x 3 template consists of three rows 
with 4 images, each row has the same 4 image names therefore the three 
latest generation that fits in to the template will be displayed. 
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X-ray image from an Image plate scanner (PSP scanner) with 
the Developer 

The Developer is used in a network where one image source is connected 
to a computer that is shared by several users. Such as a centrally placed 
X-ray scanner that is accessed from several treatment rooms. 
The purpose of the Developer is to make capturing images with a shared 
X-ray equipment as easy as possible. 
Set up the system in System - Preferences - Network  
The computer with the shared equipment is set up as a Developer server 
with a certain ID number. The computers in the different treatment 
rooms are set up as Clients to a Developer with the same ID number as 
the Developer server. 
It is possible to have more than one Developer server set on the same 
ID number. This way several image sources can be shared in the same 
practice. In larger systems with several workgroups having their own 
shared equipment, it will be practical with different ID numbers for each 
workgroup.  
Go to a presentation of the Developer. 

Color Image from Video device 

When the required hardware is installed, a continous group of tools will 
be added to the toolbar under the menu bar.  

The group belongs to the video source. A click 

on activates the video and the red dot turns green. Rem. you may 

set up the video plugin to launch automatically. A click on shows 

the video plugin settings. This is usually done at installation and is not 
explained here. Go to a presentation of the installation procedure of the 
Video plugin. 

Color Image from a Digital camera (Autoimport plugin) 

There is a plugin available the makes it possible to automatically import 
images from any drive that can be reached from the computer, it may be a 
harddrive on a computer with a digital Panoramic device or a digital camera 
or image card reader. The purpose is to simplify the often cumbersome 
handling of images in digital form. the Autoimport plugin can be setup to 
import and clear the images from the source without a single keystroke. 

The group  belongs to the Autoimport 

plugin. A click on  activates the plugin to import the images. The 

run:pptview.exe%20Developer_English.ppt
run:pptview.exe%20Videoplugin_English.ppt
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button  is available if the plugin needs to be manually deactivated. A 

setup window is reached from  . 
 

 
 
Watched folder - is the full path to where the images will be situated.  
Delete improted files - This option actually clears the source of the images 
that has been imported and thereby makes the memory card in the digital 
camera fully available for the next patient. 
Confirm import to current patient - Gives you a second chance to check 
that the right patient is selected before the images are imported. 
Check timestamp of file (together with the window for seconds) - Makes it 
possible to setup so that only the most recent images are imported. The 
images in the source will not be deleted. 
Plugin visible - Shows a plugin window on the screen while it is activated. 

Auto-start capture - When DentalEye is launched the sensor is 
automatically activated. Rem: under Preferences - Capture you may 
setup the plugin to activate automatically as soon as a new patient is 
selected. 
Every image in DentalEye is accompanied by an image info file. You can 
view this file by right-click on an image and click the Show/Edit image 

info toolbar button . 
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Image menu 

 

  New (<Ctrl>+<N>) 

The New button is used to clear the work area i.e. when creating a new 
template or a new image card. 

 Find images (<F3>) 

Searching for a patient's images. Brings up the Find images window. Note 
that you may add more than one criteria to filter out the images that you 
are looking for.  
At the top you may select one or more tooth to search for. Just click on the 
tooth/teeth you want to search for, one more click and the tooth is 
unselected. You can select to search for images with all selected teeth 
present or images with any of the selected teeth below. Mark all or no 
teeth is to simplify the marking. Click Child to bring up a child tooth-set. 
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In the next segment it is possible to select the Anatomics to search for or 
to use the Anatomic descriptions from the image properties. Select 
Anatomic descriptions by marking a description and the click the right 
arrow to add it to the search, remove from the search by marking it in the 
right box and click on the left arrow. 
 

 
 
You may also add the time span when the image searched for was 
captured. Or select only to search for particular Image types. 
There is also an option to search for a comment that has been added to 
images, for instance to find all images on objects treated with method XXX. 

 

 
 
A very swift way to search is to just mark Active, meaning all images that 
relates to the specified template. In the example below a template with 3 
generations of bitewing series is selected. This selection will result in an 
image card with 3 rows of bitewings, the images will be the last 3 series of 
the selected type. 
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 Show/Edit image info (<Ctrl>+<I>) 

For every image there is a collection of data and image information. 

 

 Show template 

The selected template is displayed on the image card. Select a template 
from the template window in the center of the toolbar. The last used 
template will be the default template until a new is selected. 

This function is useful when only a few images are going to be captured. 
When the template is displayed mark the frame that relates to the image 
that is going to be captured and the preferences, layout and rotation will 
automatically be assigned to the new image. If more images are to be 
captured even though not in sequence it is easy to mark the frame and 
capture.  

 Show/Hide list (<F6>) 

An On/off-button to show the image card without the image list. The idea is 
to provide a bit more space for the image card. 

 Import images 

DentalEye stores image files in different file-formats, that can be setup in 
System - Preferences - File format. Imported image files will be converted 
to the selected file format. 

Import contains two different functions, External import and Internal 
import. 
External import 

 Select the directory or external media at Look in: 
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 Select one or more files, hold down the ctrl button to select 
more than one image.  

 Click on the Open button. 

 
 
In the next window the imported images may get priorities assigned to 
them. 

 Destination: New series means that the images will be treated 

as an original series and locked for editing. Imageview means 
that the images will end up on a imagecard to be edited and 
saved. 

 You may save all images with the same properties. 

 The anatomic description may be assigned by choosing it here. 

 The teeth on the image may be assigned to the images by 
selecting them here. 

 Acquire means that a twain source is selected e.g. a scanner. 
(This is also available as a plugin.)   
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Image files are imported and the following information is automatically 
transferred to Show/Edit image info: 

 Capture date and time will be retrieved from Modified (not 
Created) in the source file. 

 Source will be "Imported File". 

 Path will be chosen according to image storage. 

 DPI (dots per inch) will be taken from the source file if 
available. 

 Approved will be True.Height and width in pixels will be 
retrieved from the source file. 

 Size on disk will be set according to image storage. 

 Export images 

There are a number of ways to export images from DentalEye. The Export 
image window shows up when the Export images button is clicked. 
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Source:  
Depending on what was marked when the Export button was clicked 
different alternatives are available. 
Selected images - The images that was marked before clicking the Export 
images button. Mark images in the taskpane, press down the ctrl key in 
order to select more than one image. 
All local images of Patient - All images that belongs to the active patient. 
All images in search result. 
All images in current series/image card. 
Current Series layout - captures a picture of the series/image card with the 
layout and annotations. 
Destination: 
Browse to the drive and directory where the images should be copied to. 
 File name for images: 
The name may be changed. 
File format: 
May be kept as the original format or changed to a common file format 
from the list. The compression/quality of the exported files can be altered. 
Export text file with image and patient information - Creates a package 
consisting of image files and a text file containing information about the 
images such as the patient data and image properties. This is meant for 
export to another DentalEye system. 
Attach files to an E-mail - Makes an E-mail of the selected images to export 

and launches the E-mail software installed on the computer. 

 E-mail 

Mark one or more images and choose E-mail and the E-mail software will 
be launched with the selected images attached. 
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 Change approval 

If you have not approved images that are saved while saving them you 
may mark the image and click Change approval to make them approved. If 
an image is saved as approved it can be altered back to non/approved the 
same way. When an image is un-approved it has a red mark at the top 
right corner. 

Noise reduction filter 

 Reduces the noise in an image by smoothing out the contrast.  

Soften/sharpen filter  

The tool Soften/Sharpen is used to either soften or sharpen edges in the 
image. When clicking the tool button a slide-bar appears. Drag the slider 
and the image and the image is changed correspondingly. If you want to 
remove noise use the Noise reduction tool instead. 

 Emboss 

Emboss applies a three dimentional effect to the image making it looked 
embossed. Could be useful in presentation situations. 

 Edge enhance 

Increases contrast to make the edges in the image clearer. The down 
arrow on the right opens a menu where you can select from 10 strength 
levels. When you select a level it will be applied directly and that level will 
be remembered and used as default next time. Just clicking the icon will 
apply the edge enhancement with the previously selected strength level. 
This tool is also available as a autofilter in System | Preferences | Capture. 

 Optimize brightness and compensate for X-ray attenuation  

This tool does two things to enhance the whole image based on the 
values in an area of interest, for instance while searching for caries, 
mark an area where caries could be found and the whole image will be 
enhanced for caries detection.  
Compensate for X-ray attenuation 
The first algorithm compensates the image for the problem caused by 

the fact that the X-ray beam deteriorates exponentially through thicker 
materia, which causes the grayscale in the image to have unequal steps 
in darker and brighter areas.  
Compensate the grayscale to optimize diagnosis 
This algorithm places the selected area in the middle of the gray scale 
where visual perception is optimal. Note that this optimized viewing is for 
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the selected area only. If you want to check another area, you should 

repeat the procedure there. 
The tools was developed by professor Ulf Welander and his research 
team at the Karolinska Institute. 

 Click the button and move the mouse pointer to the area of 
interest. 

 Press the left mouse button and by dragging draw a circle in the 
healthy part of the tooth, close to the suspect area. 

 Release the mouse button.  

 The whole image will now be adjusted. If you want to check 
another area, repeat the procedure. 

Zoom selections: 

 Magnifier 

This tool is a magnifying glass. Left-click on the tool button and the mouse 
pointer changes to. I the magnifying glass is used on an image card you 
will have to release the mouse button as you move from one image to 
another. 
You may also zoom in an image by using the mouse wheel.  

 Zoom 

This tool is used to select an area to zoom in to either by dragging a 
rectangle with the mouse or just to click on the spot you want to enlarge. 

 Fit image to frame 

To see the full image within the window click this icon and the image will 
change to fit inside the window. 

 Fit image to screen resolution 

Changes the image size to one image pixel = one screen pixel. The optimal 
resolution is reached by displaying one pixel in the image on one pixel of 
the screen. Since the image becomes larger than the window you will need 
to scroll to view hidden parts of the image. 

 Measurement calibration 

Used to calibrate the Ruler annotation. Click the tool, draw a line with the 
left mouse button over an object in the image with a known length, type 
the length in millimeters and click OK. The DPI (Dots per inch) value of the 
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image is changed. The DPI value is used for all measurements. Please note 

that the calibration is for this image only. Normally X-ray images have the 
DPI set from the size of the X-ray sensor/image plate and this is usually 
good enough. Use the calibration if you want to be sure of a correct 
measurement.  

If you for some reason want a new DPI value set to all new images from 
a certain source, do like this: 
Take the resulting DPI value from your calibration as seen in Image 
information. Go to System | Preferences | Capture, select the source you 
want to modify, Put a check in "Override DPI with this value" and enter 
the new DPI value. 

 The Color probe 

Use the Color probe tool to check the average intensity level of a 

selected area in an image. 
Click in the Image menu to enable the tool. Click and hold the 
mousebutton in the centre of the area in the image that you want 
examine. Drag the mouse so that you have a circle covering the are and 
release the mouse button. A message will be shown telling you the 
average intensity level, the intensity range of the image and the total 
number of unique intensity levels found in the area. 
The tool is especially useful to check the consistency of X-ray equipment. 
If you do your consistency checks by exposing the same object with the 
same settings at the same distance you should get similar values every 
time. (if your equipment is consistent). 
For 8-bit greyscale and 24-color images the range is 0-255. 
For 12-bit greyscale images the range is 0-4095. 
For 16-bit greyscale images the range is 0-65535. 

 Revert to rotated/mirrored original 

The image is reverted back to its original except for rotation and mirroring. 

 Revert to original 

The image is reverted back to its original 

Image quality in X-ray 

The image quality depends on a number of variables, the important thing 
is not that a certain variable is impressively high but rather that the 
combination of variables gives you an image which is appropriate for the 
task at hand.  
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Gray scale 

Each pixel captures one shade of gray, the image is made up of all those 
small dots each representing a shade of gray. The measure used here is 
called bit depth meaning how many shades of gray a pixel can contain. 
8 bits/pixel = 256 shades of gray per pixel. This is what standard 
monitors can show. 
12 bits/pixel = 4096 shades of gray per pixel. 
16 bit/pixel = more than 60 000 shades of gray per pixel. 
When the image is captured it seldom fills out the whole spectrum of 
grayscales available therefore it is important to at least initially use as 
much bitdepth as possible. In the process of capturing an image it is 
normally enhanced so that it is distributed over a wider grayscale and 
thereby easier to diagnose or determine between shades of gray. 
Show/edit image information – under the heading Color type you’ll see 
what kind of image it is, i.e. 12 bit gray scale, 24 bit color etc. Try the 
button Show/hide Histogram to see how well distributed the image 
information is over the grayscale. In the Histogram the scale changes 
as the number of gray scales increases. 
The image shown on the screen is, due to the screen’s limitations, 
merely an 8-bit gray scale.  
When manipulating an image, DE will work from the 16-bit original, and 
round off the screen image to 8 bits. 
To take full advantage of the 16-bit gray scale, it is recommended that 

you use the Colorize and Stretch Histogram functions. 
Images are saved in 12/16-bit gray scale. Images that are manipulated 
using tools such as Stretch Histogram are converted to 8-bit gray scale 
after the tool has been used. 

Special tools to enhance an X-ray image 

The tool does two things to enhance the whole image based on the 
values in an area of interest, for instance while searching for caries, 
mark an area where caries could be found and the whole image will be 
enhanced for caries detection.  

Compensate for X-ray attenuation 

The first algorithm compensates the image for the problem caused by 
the fact that the X-ray beam deteriorates exponentially through thicker 
materia, which causes the grayscale in the image to have unequal steps 
in darker and brighter areas.  

Compensate the grayscale to optimize diagnosis 

This algorithm places the selected area in the middle of the gray scale 
where visual perception is optimal. Note that this optimized viewing is for 
the selected area only. If you want to check another area, you should 
repeat the procedure there.
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Patient window 

The window that is opened when a patient is selected contains the 
following: 

The Task pane 

The Task pane shows the active patients: 
Images - all images stored in the archive for the patient. 
Image cards - all image cards (marked green) and original series (marked 
black). 

Search result - the result from find images . 

Clipart - a collection of smile images either purchased or from your own 
collection 
Clipboard - the clipboard is used for copy and paste within DentalEye (e.g. 
when an image needs to be moved from one patient to another. The 
clipboard is not related to a particular patient and has a limit of 9 images. 
 

 
 
Properties list 
Below the Task pane the properties of the selected object (an image, an 
image card/series or a template) are displayed. On an original series the 
properties of the images can not be edited, but on an image card some 
properties can be edited. Many of the properties displayed are required by 
the DICOM standard.  
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Image card/series area. 

The contents can be updated by using Update patient <F5>. This is useful 
in a network environment where two workstation may have the same 
patient shown. (i.e. when using the Developer function). 

An original series  is stored as an original and can not 

be changed, an image card   is open for editing. 
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The disposition of the patient window can be changed: 

Show/hide list - from the icon or in the image menu makes the task 

pane and properties visible or invisible. The proportions between the list 
and the image card/series area can be altered by draging the border to the 
left or right. 

Place task pane on opposite side - from the icon or from the Window 

menu you can change side for the task pane and the properties so that 
they appear on the left or right side of the screen. 
 By double clicking on an image it will be presented in a singleimage view. 
DentalEye can be setup to either display the single image in the window or 
to display the single image in a size were one pixel in the image will be 
represented with one pixel on the screen (which gives the optimal 
resolution). Another double click on the image or Esc takes you back to the 
image card/series view. 
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System menu 

 

 Preferences 

DentalEye is designed to adapt to the needs of the user. Consequently, the 
user has to supply the system with a certain number of parameters before 
starting. Go to the menu bar and choose System > Preferences 

 
The Preferences window appears containing following tabs: 
 

 

General 

In Language you choose in which language you want all text and 
information to appear. 
 
If the checkboxes for the items Hide images, approved or not 
approved, are set the images will not appear in the Patient image list. 
Options for Sorting order in Image list can be set. The option 
Descending is the default selection. 
If the module Clipart is in use you can see and edit in what folder the 
Clipart images are stored. 
In Preset image comments you can Edit the preset comments that later 
can be selected in the Image information dialogue. 
"Hide approved original series in imagecard list" -  hides the original 
series that always are saved when capturing new images. At the same 
instant DentalEye makes a copy of the hidden series to an image card 
which is fully editable. The original series is always saved (automatically) 
and may be brought up by unmarking the "Hide approved original series 
in imagecard list" box. The reason for the original is demands from the 
Dicom standard, but as a private practitioner without these demands the 
series is not really more of a quality assurance and therefore the option 
to hide it makes the work easier and more straight forward. 
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Appearance 

You can choose wallpapers (background images) for different parts of the 
program. There are some background colors available as bmp files under 
the ...\DentalEye\Images directory. It is easy to make a new background 
color with the Windows software Paint. 
If you check "Reset menu and toolbars to default settings..." your toolbar 
customizations will be reset to the default and all wallpaper settings are 
cleared. If something has gone wrong with your toolbar this is the 
function that brings it back to the standard. 

 

Integration 
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This is where a bridge/link/integration from a Patient Management 

software is setup. The idea is to use the patient data from the PM 
software in DentalEye and to make it easy and fast to go to the patients 
images from the PM system. 

Display 

Tools for the visual impression. 
Gamma correction: Mark the check box Enable gamma correction and 
you can choose between the alternatives Standard gamma curve and 
Perceptual gamma curve. The default Gamma value is set at 2.35. If 
you know the gamma value of your screen you can change the value by 
clicking the set button (...). 
There are some General settings available for Single view mode, zoom 
scaling method and whether date and time of capture shall be displayed 
on the images as a tag. 
 

 
 
A mark in the checkbox Compensate exponential X-ray attenuation, 
will automatically run an algorithm on all X-ray images opened on 
imagecards. It will give a linear representation of the X-ray absorption-
capacity for the material in question. The purpose is to give an intuitively 
correct impression of thickness/density.  
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Capture  

Set the time that an image shall be displayed full screen when captured. 
Set to 0 seconds to disable the full screen show. the idea is that 
immediately after the capture check the image quality on the full screen 
size, if the image failed just click on the frame just exposed and do a 
retake. 
Write the name of the x-ray emitter used with this PC. This is used as 
default for the x-ray emitter field in image info when an x-ray image is 
captured on this PC. 
Auto save options makes it possible to set up DentalEye so that an 
image will be automatically saved either as approved or as non-
approved. 

Show active seconds left for sensor. Some sensors have a limited active 
time. If that time has elapsed when the exposure is done no image will 
be produced. With this box checked the remaining time will be displayed. 
Demand exposure information before approving image: If the x-ray 
control book is in use, exposure data is needed in image info. With this 
box checked an image cannot be approved until this data is provided. 
 

 
 
Source specific auto filters and settings 
For each image source choose if:  

 the image shall be mirrored automatically (some image sources 
deliver mirrored images. That can be corrected here) 

 noise reduction should be applied automatically. 

 edge enhancement should be applied automatically. Please note: 
Edge enhancement with the currently selected level will be 
applied. 

 the freshly captured image shall be displayed full screen when 
received. 

 the device shall activate automatically when a new patient is 
selected. With sensors that needs to be manually activated this 
makes the activation automatically as soon as a new patient is 
selected. 
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 blank or bad images should be discarded. If a bad image is 

received and this option is checked you will be notified with a 
message box, but the image is discarded. 

 it should override DPI with a selected value. This is useful when 
an image source always gives the wrong value and you know 
the correct one. See also Measurement calibration. 

 a certain template always will be used when capturing from this 
source. Put a check in the checkbox and select a template from 
the list. This choice will override the default template selected 
on the main toolbar. Useful when alternating between video and 
X-ray captures. If you select a certain general template for the 
video plugin here, you don't have to change default template 
everytime you switch between video and X-ray. 

 

 

 

Security 

This tab contains a list of users and options to give users different 
security permissions. 
The first alternative is Use Windows login, which automatically adds the 
users that logs in to Windows. This is the default option. The list of users 
is automatically created from all Windows login names that has used the 
current database. The list always contains a "Default user" wich is a 
template, meaning that all new users are given it's permissions. After 
installation the "Default user" has access to all permission levels, except 
"Delete images". 
The other alternative is to Use application login, which means that users 
has to be added manually and that each user who logs in to DentalEye 
will be prompted for a password. When this alternative is preferred the 
Add user and Change user buttons will be activated. Adding a user opens 
up this window: 
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A user with "Administrate security" can edit the permission of users, 
including the Default user. If you remove "Administrate security" 
permissions from "Default user", no new users will be able to change 
permissions. 
Deleting a user can only be done by users having administrate 
permissions. You cannot delete yourself. 
The "Delete images" permission also allows you to move images to other 
patients and to delete templates. 
If the administrative user has, for some reason, lost administrator rights 
there is a Force Administration mode button. This procedure is 
password protected and requires the cooperation of your supplier. 
 

 
 

Image format 

The image format can be setup for two types of images: 
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8-bit gray and 24-bit colour images, with the options: Lossless 

jpg, lossy jpg and lossy cmp. 
12- and 16-bit grayscael images, with the only option lossless jpg. 
Lossy means that the image has lost some details when it is 
compressed, the size of the image file is a lot smaller.  
On an intraoral X-ray image a typical size could differ like this: 

 Lossy cmp 153 kB 

 Lossy jpg 202 kB 

 Lossless jpg 1124 kB 

  

 

Consistency check 

This is a tool for documentation of regular checks of the x-ray equipment. 
System > Consistency check. This opens a patient named 'Consistency 
check' with no patient info form available. Images can be captured and 
stored as well as series/image cards. Images from exposures done in a 
specified manner at regular times can be saved and compared in order to 
document the consistency (or deterioration) of the equipment. Use the 
Color probe tool to check the average intensity level in test images. If you 
record this value as a comment on the image you will be able to compare 
this the next time you check consistency. 

Template list 

The created and saved templates are sorted numerically and 
alphabetically in a Template list. To get your own order give the 
templates names beginning with numbers when saving. E.g. 1 in front of 
the template name you want at the top of the list. To Rename a 
Template use the Save As function. 
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Test run template 

Once the template is ready it should be tested and corrected. If you are 
uncertain of the rotations, start with 0 (zero) in the rotation fields. The 
test run will determine the values you need to put in. Sensors placed 
vertically will either work fine with 0 or require 180 degrees rotation. 
Horizontal placement will require 90 or 270. 
1 Find a patient and select the template to be tested from the "Default 
template" listbox on the main toolbar. 

2 Click the Show template button  to display the template on the 

image card. 
3 Capture images and left-click the image that hasn't appropriate 
rotation. 

4 Click the toolbar button  Rotate 90 degrees clockwise and 

rotate each image until it is correct.  
5 Make a note of which rotation was required. This value is to be applied 
to the corresponding frame in the template.  
6 Exit this patient and enter the Template manager by clicking on the 
Templates tab. 
 

 
 
7 Select the Template and mark the frame, change the properties as 
explained in Create and edit Templates. Don´t forget to save the 
changes. 
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Tools menu 

 
 

 Show/Hide grid (<Ctrl>+<G>) 

Only available in Template mode. 
An On/Off-button to display a grid on the template to make it easier to 
align the frames. 

 Delete (<Del>) 

Delete images, image cards and templates. Requires user permissions. 
See a presentation on how to move and delete images. 

 Add image frame to template 

Only available in Template mode. 
Adds a new image frame to the template at teh top left corner. Rem. if you 
add more than one frame they will get stocked above each other. 
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 Show/edit anatomic descriptions 

DentalEye works with an index of anatomic descriptions, which every clinic 
can organize, reflecting their own procedures and requirements. See 
Anatomic descriptions. 
 

 Developer 

The Developer is used in a network where one image source is connected 
to a computer that is shared by several users. Such as a centrally placed 
X-ray scanner that is accessed from several treatment rooms. 
The purpose of the Developer is to make capturing images with a shared 
X-ray equipment as easy as possible. 
Set up the system: 
The computer with the shared equipment is set up as a Developer server 
with a certain ID number. The computers in the different treatment 
rooms are set up as Clients to a Developer with the same ID number as 
the Developer server. 
 

 Control book 

X-ray exposure documentation 
The X-ray control book reports the X-ray dose for one patient or all 
patients together for a selected time span.  
Tools>X-ray control book. Click Show list to the right at the bottom. 
When an exposure is done it can yield one of the following cases: 
1 An image is captured and approved. 
Before approval the image info dialog will be displayed. The responsible 
person is supposed to check data , the check is confirmed with a click on 

the OK button. 
2 An image is captured and temporarily left as non approved. 
When images are saved without approval, the image info dialog is not 
displayed automatically. If non approved images are saved straight on, 
the temporary values for ms, kV, mA, and mSv are deleted. In the x-ray 
control book the image is displayed with zero in these fields. Therefore 
it is strongly recommended that the capturing person opens the 
image info dialog and confirms data for all images before saving.  
3 An image is captured and later on deleted. 
Before deleting the image you have to open the info dialog and note the 
content of fields: Capture date and time (the time part may be omitted), 
previous exposure (date), x-ray emitter, values for ms, kV, mA, and 
mSv, capturing person, and pregnant when exposed. Tools > Exposure 
without image. An image info dialog is displayed with some default 
information. Edit the fields till you have the correct info from the image 
to be deleted. Click OK. Delete the original image. 
4 No image is captured. 
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DentalEye will not receive any information about the event. The 

capturing person is responsible for the documentation. Tools 
> Exposure without image. An image info dialog is displayed with 
some default information. Edit the fields till you have the correct info for 
the exposure. Click OK. 
 

Exposure without image 

This function makes it possible to register an exposure (a radiation dose) 
on a patient in the "control book" when the image fails or is deleted. 

 Presentation overview 

Show images from clipboard in a presentation view. The procedure is to 
right click on the images to display and then choose copy. Then click the 
Presentation overview icon and the images will be diplayed on a full screen 
with a black background. To empty the clipboard go to Edit - Clear 
clipboard. 
 

 Show/hide analysis tools 

To hide or show the particular group of tools. 
 

 Show/hide image tools 

 

To hide or show the particular group of tools. 
 

 Show/hide cosmetic tools 

To hide or show the particular group of tools. 
 

Simulate X-ray 

To simplify the learning of the image capture procedure, DentalEye is 
equipped with 4 archive images and a simulator function. Press 
<Ctrl>+<X> to activate the X-ray simulator and “expose” one image
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Window menu 

 

 

Update patient 

If there are changes on a patient file made from another computer they 
might have to be updated on current computer by Update patient or F5. 

Place taskpane on opposite side 

To shift places between the Task pane and the Image card, choose 
from the menu Window. Do it again to get back to the default position. 

Images 

Displays the patients images in the taskpane.  

Image cards/Series 

Displays the patients images in the taskpane.  

Search results 

Displays the search result in the taskpane.  

Clipart 

Displays the Clipart directory in the taskpane. 

Clipboard 

Displays the images in the Clipboard in the taskpane. 

Templates 

Displays the Templates in the taskpane and opens a clear area to work 
with Templates. 
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Window features 

DentalEye is a Windows-based program. Thus all handling of windows 
with tool buttons, mouse and keyboard is according to Windows 
standard.  The first window level is the main window, which can be 
resized. At the side of the screen you will find the Task pane a window 
containing a list of image cards/series, images, search results, Clipart, 
Cliboard or Templates.  

Resize Image card area 

The Image card (for both images and templates) has a special feature. 
When the mouse pointer comes to the right or lower edge of the image 
card it turns into a double arrow. Then you can press the left mouse 
button and move the edge. As long as you keep the button pressed the 
window behaviour is normal, but when you release the button an 
automatic adjustment takes place. 
The image card keeps its proportions (length to width ratio) and expands 
till it hits one of the borders. That is the same as Fit image to frame. 
Images or template frames on the image card follow the expansion. Thus 
you can increase but not decrease image/frame size by changing image 
card size. 
When the edge of the image card is close to the edge of the window 
(always the case on at least one edge), it may be hard to distinguish if 
the double arrow belongs to the window or the image card. Move the 
mouse pointer slowly and study the changes. 

Single view 

Single view is a third window level. You get to it by double-clicking an 
image on the image card (not in the image list). The single view window 
is placed on top of the image card 
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